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Exploration 18:  Sequences & Scatter Plots

A sequence is a function whose 
domain is the set of integers.

a)  Display the sequence 1, 2, 3, 4, 5 in column A of a spreadsheet.

b)  Use a formula to display in column B, the numbers that are double those in column A.

c)   Use a formula to display in column C, numbers that are 5 more than those in column B.

Example 1

Solution

Bob Frankston and Dan Bricklin co-founders of 
the electronic spreadsheet in 1980

In the previous Explorations, we saw that the concept of 
a function evolved from a table of values to its current 
form introduced by Cantor in 1874. However, the rep-

resentation of functions continues to evolve. In 1978, Dan 
Bricklin, while a student at the Harvard Business School, 
collaborated with Bob Frankston in the development of 
the first electronic spreadsheet known as VisiCalc. This 
spreadsheet was simply a table of rows and columns, but it 
had the ability to use data from one or more cells as input 
to functions defined in other cells. This capability revolu-
tionized accounting practices and brought fame and fortune 
to its young inventors. Today, Excel and Numbers are the 
spreadsheets most commonly used in the business world.

The Examples in this Exploration show how we can use spreadsheets to 
represent functions and special functions known as sequences. 

A sequence is an ordered list of numbers such as 1, 3, 5, 7, 9,  … , or 
2, 4, 8, 16, 32, … . The numbers in a sequence are called the terms of the 
sequence e.g., 5 is the third term in the first sequence and 16 is the fourth 
term in the second sequence.

The terms of the sequence 1, 3, 5, 7, 9, …, are generated by the formula    
2n – 1, and the terms of the sequence 2, 4, 8, 16, 32, …  are generated by the 
formula 2n. Example 1 shows how we generate sequences in TI-nspire. 

a) To access the Lists & Spreadsheet application we press: c  ¢   ¢   ¢ · 
and we enter the numbers from 1 through 5 in column A.

b)  In the header row of column B (see display) we enter:

=2rA/(  ¢  ·

Column B displays the numbers that are double those in column A.
 
c)  In the header row of column C (see display) we enter:

=B/(  ¢  +5·

Column C displays the numbers that are 5 more than those in column B.
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Algebra I with TI-nspire™: Semester 1 

       Worked Examples

a) Construct a scatter plot for the sequence in column C of the spreadsheet in Example 1 
corresponding to the sequence of integers in column A.

b) What do you notice about the shape of the scatter plot? Trace along the points in the 
scatter plot to display the ordered pairs that define the sequence. 

c) Return to the spreadsheet and change the numbers in column A from 1, 2, 3, 4, 5 to
 10, 20, 30, 40 50. Then construct the scatter plot as in part a above.

Example 2

Solution

a)  Before we form a scatter plot, we must name the data in each column of the 
spreadsheet. To do this, we place the cursor in the top row of the spreadsheet 
(the row above the header row). In top cell of column A, we enter the name 
integers and press ·. Similarly we name the list of numbers in column B 
doubles and the list of numbers in column C output and press ·.

To access the Data & Statistics application we press: c  ¢   ¢   ¢  ¢ ·.

To display a scatter plot, we move the pointer to the x-axis until the prompt 
Click to add variable appears and press ·. We choose integers and press 
·. Then we move the pointer to the y-axis and choose output. The scatter 
plot of the ordered pairs is shown in the display. .

b)  We observe that the points in the scatter plot seem to lie on a straight line.

To trace along the graph, we enter: b > Analyze > Graph Trace. Pressing  
¢ repeatedly moves the cursor through the points on the graph to (5, 15). 

c) To move back one page from the scatter plot in part b to the spreadsheet, 
we press: /  ¡.  Then, we place the cursor in column A and change the 
numbers 1, 2, 3, 4, 5 to 10, 20, 30, 40, 50 respectively. As we do this, the 
numbers in columns B and C change accordingly. 

To construct the scatter plot, we proceed as in part a) above. We obtain the 
plot shown in the display, and trace as in part b to the point (50, 105).

To widen a column press:

b > Action > Resize > Resize Column Width

Then press ¢ repeatedly and press · to fix 
the column width.

We see that spreadsheets enable 
us to have the outputs change auto-
matically when we change inputs! 
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       Worked Examples

Display the values of the function 5(2x + 40) on a spreadsheet for integral values of x from 
1 to 31. Use the spreadsheet to find the value of x when 5(2x + 40) = 410.

Example 3

Solution

Remember me, Professor Maestro? 
I’m back to show you the magic 
of spreadsheets!

You may recall that in Exploration 6, Professor Maestro had students start with the day 
of their birth that we represent by x. Then the student computed 5(2x +40) and from 
this number, Professor Maestro would deduce x. His trick was to calculate the “undo” 
or inverse function. However, in the following Example 3, you will discover an easier 
method using a spreadsheet.

To access the Lists & Spreadsheets application we press: c  ¢   ¢  ¢ ·.

We place the cursor in the header row of Column A and enter: 

b > Data > Generate Sequence.

We obtain the sequence template shown in the display. Since a sequence is 
a function defined on the integers, the template uses n rather than x as the 
variable and u(n) rather than f(x). Therefore, to complete the template, we 
enter the formula in the box for u(n) as 5(2n + 40) as in the screen display.

We press e to move to the next box. The first term of the sequence is its 
value when n = 1, i.e., 5(2 + 40) or 210. We enter 210 in the box titled Initial 
Terms.

Since there are only 31 possible days in a month, our sequence has a 
maximum of 31 terms, so we enter 31 in the box titled Max No. Terms. We 
then tab down to the OK box and press ·.

Column A of our spreadsheet displays the outcomes corresponding to
 n = 1, 2, 3, …, 31. 

To find the value x (or in this case n) corresponding to 410, we scroll down 
column A until we reach 410. The number on the left of 410 is 21 indicating 
that x = 21 is the input number that yields the number 410.

Professor Maestro has, indeed, discovered how to exploit the power of the 
spreadsheet!
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Exercises and Investigations

x. Complete Exercise w before proceeding. Then follow the 
steps in that exercise to obtain the sequence template.
a) To generate the sequence of natural numbers from 1 to 50, 
complete the template as in the display and click OK. 
b) Then in the top row of 
Column A enter natnos to 
name that sequence.
c)  Follow the procedure in 
Example 2 to create a scatter 
plot of olympicyr vs. natnos.
Describe the shape of the plot.
d)  Trace along the scatter plot to check your answer to wf. 

y. Complete Exercise x before proceeding. Then open a 
spreadsheet by pressing c  ¢   ¢  ¢ ·.

 • In the top row of Column A, enter natnos.
 • In the header row of Column B, enter =a[ ] + 1.
 • In the header row of Column C, enter =a[ ]*b[ ]. 
 • In the header row of Column D, enter =c[ ] /2.
a)  How are the numbers in Columns A and B related?
b)  How are the numbers in Column C related to the numbers  
  in columns A and B ?
c)  How are the numbers in Columns C and D related?
d)  Suppose a number in column A is represented by n. Write  
   expressions in n for the numbers in Columns B, C, and D.
e)  Use your expression in n to calculate the number in row  

50 of column D. Compare this with the number you found 
in the TI-nspire Investigation in Exploration 13.

z. Professor Maestro is at it again! These are his instructions.

Open a spreadsheet in TI-nspire by pressing c  ¢   ¢  ¢ ·. 
• In the top row of Column A, enter natnos.
• In the header row of Column B, enter:  =a[ ] + 1.
• Enter the appropriate expressions in the header rows of 
Columns C, D and E. Examine the numbers in Column E and 
explain how Professor Maestro determines the input number 
n from the output number in Column E.

A B C D E 
Write 

n – 1 in 
box C

Start with 
a positive 
integer n.

Write in box D 
the product of 

box B and box C

Write 
n + 1 in 
box B

Add 1 to 
Box D. Give 
the result.

Write 
n – 1 in 
box C

q. a) Suppose a friend asks you, “What is a sequence?" Write 
a sentence or two to describe how you would answer.
b)  A quarterback calls out the signals, “4, 6, 3, 2.” Is this a 
sequence? Explain why or why not.

r. Identify a pattern. Write the next term of each sequence.
a)  5, 8, 11, 14, __, …
b)  –6, –9, –12, –15, __, …
c)  2, 4, 8, 16, __, …
d)  1, 4, 9, 16, __, …

s. Give an example of a function that is not a sequence.

t. The nth term of an infinite sequence is defined by u(n) = 1/n.     
Note: We use u(n) instead of f(n) for sequences.
a)  Write the initial term (i.e., first term) of the sequence.
b)  Write the 20th term of the sequence as a decimal fraction.
c)  Write the 100th term of the sequence as a decimal fraction.

u. The sequence of even integers is 0, 2, 4, 6, … .
a)  Write the initial term of this sequence.
b)  Write the 9th term of this sequence.
c)  Write an expression for the nth term of this sequence.
d)  Use your expression to calculate the 50th term.

v. Write an expression for the nth term u(n) of each of the 
sequences in Exercise r. 

w. The Olympic Games 
originated in ancient 
Greece around 776 B.C. 
In 1896, the Modern 
Olympic Games were 
instituted. It was agreed 
that the first (summer) 
games would be held 
in 1896 and every four 
years thereafter – known 
as the  Olympic Years. The photo shows the Olympic facility 
where the athletes trained in preparation for the games.

a)  Write the first four terms of the sequence of Olympic Years. 
b)  In what year were the 9th Olympic Games held?
c)  Write an expression for the nth Olympic Year.
d)  To open a spreadsheet in TI-nspire press c  ¢   ¢  ¢ ·.
 Then enter b > Data > Generate Sequence to obtain the 

sequence template.
 Complete the template as in the display and press ·.
e) Scroll down to the 9th row 

of Column A to verify your 
answer in part b.

f) Scroll to find the number 
of the Olympic games  that 
were held in 1996.

T I - n s p i r e  I n v e s t i g a t i o n

What is the 50th 
Triangular Number? 

Follow the instructions in Exercise y to create a spreadsheet 
with the natural numbers (natnos) from 1 to 50 in Column 
A and the triangular numbers in Column D. Then use the 
procedure in Example 2a to construct a scatter plot of 
triangularnos vs. natnos. Trace along your scatter plot to 
display the 50th triangular number. 

photo courtesy of Teresa Kelly



Answers to the Exercises & Hints for the Investigations

160

The number 
of dots in an 
interval on 
the horizontal 
axis indicate 

the number of people with IQ in that 
range. Most people cluster close to 
an IQ between 90 and 110. 

Exploration 17 cont’d

x.  a)   b)

c)    d)

e)    

(–3, –14) is on the graph.
(4, –7) is not on the graph.

(–3, –5) is not on the graph.
(2, –10) is on the graph.

(–4, –7) is on the graph.
(4, –7) is not on the graph.

(–1, –12) is not on the graph.
(–1, 12) is on the graph.

(–5, 10) and (4, 3) are on the graph.

Hint for the TI-nspire Investigation

Exploration 18
q.  a) A sequence is an ordered list that assigns a number to each of the 
natural numbers 1, 2, 3,… in turn.
b)  Yes, the signals constitute a finite sequence of 4 terms. The first term is 
4, the second term is 6, the third term is 3, and the last term is 2.

r.  a)  Each term is 3 more than the previous term. The next term is 17.
 b)  Each term is 3 less than the previous term. The next term is –18.
 c)  Each term is double the previous term. The next term is 32.
 d)  The nth term is n2. The next term is 52 or 25. 

s.  Answers will vary, but a function whose domain is not the natural 
numbers is not a sequence. e.g., f(x) = x2  is not a sequence if the domain 
of f(x) is the set of real numbers. Also a set of ordered pairs such as:
{(2,3), (5, 9), (1, 7)} is a function but not a sequence because this is not 
an ordered list.

t.  a)  initial term is 1 b)  20th term is 1/20 or 0.05
 c)  100th term is 1/100 or 0.01 

u.  a)  initial term is 0 b)  9th term is 2 × 8 or 16
 c)  nth term is 2(n – 1) d)  50th term is 2(50 – 1) or 98

v.  a)  nth term is 3n + 2 b)  nth term is –3n – 3
 c)  nth term is 2n  d)  nth term is n2

Exploration 18 cont’d

w.  a)  1896, 1900, 1904, 1908 b)  1928 
 c)  nth Olympic year is 1896 + 4(n – 1) 
 e)  The display shows 1928 f)  The display shows the 26th.

x. c) The plot is a straight line d)  The trace yields (26, 1996). 

y.  a)  The numbers in Column B are greater by 1 than those in A.
b)  The numbers in Column C are 
the product of those in A and B.
c)  The numbers in Column D are 
half of those in C.
d)  The expressions in Columns B, 
C and D are respectively:
n + 1, n(n + 1), and n(n + 1)/2.
e) The number in row 50 of 
column D is 50 × 51 ÷ 2 or 1275.

z.  If n denotes the number 
in Column A, then the 
expressions defining Columns 
B, C, D, and E are respectively, 
n + 1, n – 1, (n + 1) × (n–1), 
and n2. To determine the 
number in Column A from 
a given number in Column 
E, Professor Maestro merely 
takes the square root of the 
number in Box E.

Hint for the TI-nspire Investigation

The scatter plot is shown in the display with the 
50th triangular number highlighted in the trace. 


